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Todays goals:

• Get you ready, and give you practice, really doing analysis in InterSpec

• Useful smaller-features

• Energy Calibration

• Nuclide ID – will use Trinitite spectrum as example

• Fitting nuclide activities, shielding, and ages with of point-sources (more Trinitite ex.)
• We’ll talk about limitations, etc
• Surface contamination and volumetric (trace) source activities

• Detector response functions: creating your own vs using existing ones

• Viewing search-mode or portal data

• Other calculations: nuclide decay, dose, cross-section, …
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Please work-along, or tinker around with InterSpec as we go along today

The example spectrum files at https://sandialabs.github.io/InterSpec/tutorials/



Useful smaller-features



Scaling spectra

By default, InterSpec will live-time normalize the background and secondary spectrum to the foreground
§ You can manually enter the scale factor you want on the “Spectrum Files” tab

You can also drag the “Y-Axis” scalers to adjust the background/secondary normalization
§ Particularly useful for comparing spectra against reference spectra
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The “Y-Axis Scalers” should show 
up by default when you display 
multiple spectra, but you can 
show/hide them from the “View” 
menu



More Display Options – peak labels

You can add or edit the user label using the 
“Peak Manager” tab, or the “Peak Editor”
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You can choose to show peak 
energy, nuclide, gamma, and/or 
a user label for each peak



More Display Options – chart options

Linear Y Scale: occasionally useful when squinting at tiny peaks or features. 
“Ctrl-L” will toggle between log/linear

Vertical/Horizontal Lines: sometimes useful for reports or HPGe spectra

Compact X-Axis: good for screens with limited real-estate

Hide Tool Tabs: entire screen becomes spectrum; the tabs contents become available in the “Tools” 
menu
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More Display Options – multiple detectors

If the spectrum file contained multiple detectors, you can control which ones the data is 
displayed from “View” -> “Detectors”
§ Can be useful to isolate left/right side of portal monitors, or to energy calibrate sub-set of detectors
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A note about the spectrum display:

When there are more spectrum channels than pixels, multiple channels are summed 
together for display.

As you zoom in and out, this is dynamically adjusted.

The time-history plot does the same thing, but can also be turned off.

Seems to be the least-misleading way to display the data in discernable way.
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Saving screen-shots

You can save a screenshot of the spectrum 
as either a PNG or SVG file

The picture will be the same size as is 
currently displayed – but of course SVG is a 
vector format so can be rescaled well.
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You can also export the current spectrum as 
an HTML file, that will have an interactive 
spectrum embedded into it, with similar 
controls as inside InterSpec.

Will have peaks, reference lines, etc



Exporting CSV files

A lot of places throughout the app you’ll see little links to download things – these 
export text-based files useful for getting information into other applications.

• Peak information, nuclide decay info, energy calibration, detector response function, 
etc.
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Using the CSV files

For a number of these files, you can drag-n-drop them back into InterSpec.  

The peaks CSV is the most useful: when you drag the CSV onto the app, the peaks will be 
refit, so count-rates or exact resolution doesn’t need to match – useful if you work with 
similar spectra a lot.
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Having multiple files open

When you open a new spectrum file, all your previous files get 
kept in memory and any work done on previous spectra is not 
lost, until you close InterSpec

You can go back to any of the previous spectra easily
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Saving your work

If you export to a N42-2012 file, then all 
of your peaks, DRF, and fit 
activities/shielding will be saved inside 
the file and restored when you load 
back into InterSpec.
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Or you can store everything in InterSpecs’ internal database.  
◦ If  you do this you can “Tag” snapshots of  your work, or if  you 

load the original spectrum some time later, you will be let 
known you can pickup where you left off  before

There is also an option to store your session when you quit 
InterSpec, or switch spectrum files
◦ You cant currently access these auto-saved spectra via the GUI, but 

if  you load the same spectrum file later, a dialog will come up 
asking if  you want to pick up where you left off



Background Subtraction

InterSpec has two background subtraction options:

• “Background Subtract” – a visual subtraction for plotting only
• Can cause display affects to the peak continuum

• “Hard Background Sub…” – background counts are 
subtracted from foreground to make a new spectrum 
• This is what most people are used to
• I personally prefer to avoid this, but in practice its probably 

what works best
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not background-subtracted background-subtracted

same peak



Files with multiple samples

If a file has multiple measurements inside of it, you can also select which samples you 
want to display
§ If you want to use multiple samples summed, you can enter text like:

§ “1-10” to sum samples 1 through 10
§ “2,3,5-7” to sum samples two, three, and five through seven 

§ If you need to sum samples across files, see the “Spectrum Manager…” to create new files with 
all the samples you want

§ For search-mode or portal data there will be a time-chart to let you do this summing easily
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Inspecting spectrum file contents

The “File Parameter” tool lets you look at, and edit information in spectrum files.

Sometimes spectrum files contain “meta” information that turns out to be useful, that will 
show up here; if you didn’t take the measurement, it may be worth checking this out to make 
sure you aren’t missing something (it can also be useful to open the file up in a text-editor as 
well)
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Tools -> “File Parameters”



Feature Markers

Not all peaks and features in a spectrum are caused by full-energy absorption of a gamma/x-ray
§ Escape peaks fall 511 keV and 1022 keV bellow the full energy peak 
§ Sum peaks at double the actual energy
§ Compton peaks or Compton edges can be confused for peaks, or scatter angle can be important to figure out

As you move the mouse on the spectrum, lines will be drawn on left and right to show where the source peak and 
feature peak would be for the current mouse position 

You can also try right-clicking on a peak and InterSpec will let you know about sum and escape peak possibilities
§ Uses both the peaks you’ve fit, as well as the automated peak search results, so it works pretty well

If there are some peaks left in the spectrum that you cant identify, this tool is worth a try, especially for HPGe
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Comparing counts in an energy range

The “Energy Range Sum” tool lets you compare count rates between foreground and 
background/secondary spectra

• You can access via “Tools -> Energy Range Sum” menu, or “shift + alt + mouse-drag”
• A common use-case is comparing continuum counts above the 2614 keV peak to check if 

neutrons are present
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Energy Calibration



Energy Calibration – a primer

Almost all spectrum files use one of:
§ Polynomial:

§ The energy of channel i is: 𝐸! = 𝑐" + 𝑐#×𝑖 + 𝑐$×𝑖$ + 𝑐%×𝑖% + …
§ Spectrum file gives the coefficients 𝑐&, usually 2 or 3 of them, but sometimes up to ~5.   
§ c0 is often times called offset, c1 is gain, c2 quadratic
§ The most common energy calibration form

§ Full Range Fraction (FRF):
§ The energy of channel i is: 𝑙𝑒𝑡 𝑥! =

!
#()*++,-.

then 𝐸! = 𝑐" + 𝑐#𝑥! + 𝑐$𝑥!
$ + 𝑐%𝑥!

% + (!
#/0"1"

§ Primarily used in PCF files (GADRAS and related), but also in some N42-2006 files.

§ Lower Channel Energies:
§ The lower energy of each channel is given.  
§ Sometimes the upper energy of last channel is also given
§ Common in CSV or simple ASCII files, but can also be in N42 and PCF files

A detectors calibration may not always be great, so sometimes adjustments to the 
coefficients of polynomial or FRF coefficients may be necessary before analyzing 
data – there are a few ways to do this in InterSpec
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Energy Calibration (cont.)

You can manually adjust parameter 
until the photopeak's line up with 
where they “should” be
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Energy Calibration (cont.)
You can fit for peaks associated with nuclides, and use those to “fit” for the best 
coefficients
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1) Select the peaks you want to use for the fit
2) Select which order coefficients 
you want to fit for3) Push “Fit Coeffs”



Energy Calibration (cont.)

You can graphically recalibrate by 
holding Ctrl+Alt and dragging the 
spectrum to where you want
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If  Ctrl+Alt+drag again within 2 minutes, one of  the 
options will be to preserve your last calibration
◦ This is useful to adjust both the gain and offset using a 

low and high energy peak; when you do the second 
calibration this option will keep your previous peak at the 
same location you drug it to 



Energy Calibration (cont)

When you load a new spectrum, 
and its from the same detector 
as your previous spectrum, and 
the energy calibrations are 
different, you will be asked if 
you want to keep the previous 
calibration
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Further options having to do with 
energy calibrations will appear in the 
Energy Calibration tab depending 
on context



Energy calibration practice

You can assume you need at least a quadratic equation.

The truth answer will be given in about 10 minutes – if you are not a power energy calibration user, feel free to ignore this 
next 10 minutes, and instead determine the energy calibration
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The file “th232_energy_cal_practice.n42” was generated without an energy 
calibration – please try to determine it



Energy Calibration - complications

Some detection systems have multiple physical detectors, and/or may provide many 
different measurements all within the same file
§ Each detector may have a different energy calibration
§ The energy for a given detector may change for each sample

In these cases you will have to select how you want the changes applied
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Energy Calibration – complications (cont.)

You can select which 
detectors, samples, and files 
to apply the changes to here
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You can see the calibrations for 
each detector using this menu, 
which will appear when you load a 
spectrum with multiple detectors



Energy Calibration – complications (cont.)

For multiple detector systems, or where calibration changes throughout file:
§ If you manually change a coefficient, the effect of that change is applied to all the other 

calibrations in the file
§ E.g., the peaks for all detectors will move the same amount
§ This isn’t as straight forward as changing the coefficients of each calibration by the same amount, but InterSpec takes 

care of the math

§ If you want to adjust the calibration of just one detector, use the “View” → “Detectors” menu 
to change which detectors are being shown, to just that one detector

§ Options also appear on the GUI to let you apply changes to just the visible samples, or all the 
samples, or just the foreground/background/secondary spectrum

§ Changes are not applied to other files you may have open, but aren’t being displayed; use the “Multi File Cal…” option 
for that, or after an adjustment, change back to the other file you want, and you should be prompted if you would 
like to use the new calibration
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Energy Calibration – nonlinear deviation pairs

Non-Linear deviation pairs are typically used to account for intrinsic non-linearities not captured by a lower-order 
polynomial

§ Non-linear deviation pairs are typically static over time and temperatures and wont need to be adjusted after initial 
characterization

The deviation pairs are actually the nodes of a cubic spline that specifies a change to add on-top of the polynomial or 
FRF calibration

An example use is:
§ Use the 239 keV and 2614 keV peak to determine offset and gain
§ Then if the 1460 keV K-40 peak is at 1450 keV, you would a deviation pair with energy of 1460 and offset of 10
§ You would also add a deviation pair with offset 0 at 0 keV, and one with offset of 0 at 2614 keV

Practically, if you are trying to use a quartic or above calibration, you should consider non-linear deviation pairs
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Energy calibration practice - Answer

Truth answer:
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However, we probably don’t have enough power with this lower resolution spectrum to 
get the small cubic parameter.



Nuclide ID



Nuclide-ID practice

Please load the “trinitite_sample_b.n42” and “trinitite_sample_b_background.n42” files available from 
Tutorials section of https://sandialabs.github.io/InterSpec/

• Measurement is from Dave Mercer of Los Alamos National Laboratories

• This is sample “B”  in “Gamma and Decay Energy Spectroscopy Measurements of Trinitite” –
available at  https://arxiv.org/abs/2103.06240 (an excellent discussion and analysis!)

• 125.6 grams of typical green-glass pieces
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https://sandialabs.github.io/InterSpec/
https://arxiv.org/abs/2103.06240


Lets take 15 minutes to do nuclide ID (or take a break)

Please fit, and associate the nuclides for as many non-background peaks as you can.

Later today we will fit for activities, and then back-decay them to time of detonation, 
and then compare to the paper.
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Results

Co-60, Ba-133, Cs-137, Eu-152, Eu-154, Pu-239, Pu-241
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Fitting activity and shielding



Peak-Based Differential Attenuation Analysis37

Goal: Take gamma spectrum of radioactive source, and from the spectrum 
potentially determine:

1. The amount of shielding
2. The effective atomic number of shielding
3. The source activity
4. Isotopics of material
5. The source Age



Differential Attenuation – Pretty Basic Stuff38

The photon cross-section with matter varies by both photon energy and material 
atomic number
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Detector Response Function39

For peak-based spectroscopy, we care about the efficiency of detecting the full-energy of 
incoming gammas – i.e., efficiency to see peaks in the spectrum.

The efficiency is commonly given as either:
§ Intrinsic: A function describing the fraction of gammas striking the detector face, who’s full 

energy will be absorbed
§ Absolute: The fraction of full-energy absorptions , for a source at a given distance

Usually given in a form like: exp(-343.63 + 269.10*log(x) -83.80*log(x)^2 + 13.0*log(x)^3 -1.01*log(x)^4 + 0.03*log(x)^5)



Source Gamma Intensities:40

ENSDF gives us the energy and intensity of gammas for each nuclide

The Bateman equations let us determine these probabilities for decay chains as a 
function of time



Putting it together:41

We know a nuclides output gamma spectrum (as a function of age)

We know the gamma attenuation (as a function of energy and atomic number)

We know the efficiency for a gamma to end up in a photopeak (as a function of 
energy, source to detector distance, and detector face size/shape)

We can fit photopeak’s in spectra to determine their area

----------------------------------------------------------------------

Its now just χ2 or -log(likelihood) fit to figure out the the unknowns



Comparison of Peak-Based analysis to Full Spectrum 
analysis
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Advantages of peak-based:
§ No background is needed (unless you want to use source peaks that overlap with background 

peaks)
§ Does not depend on scattering of your environment.

§ For full spectrum you need to characterize the DRF to your environment, ex. concrete floor, 1m high, how big the room is, 
etc.

§ Detector characterization much simpler (either do by measuring a couple check sources, or a 
simple GEANT/MCNP calc can be good enough)

§ Gamma transport through material is trivial; doesn’t really depend on geometry
§ Peaks and spectral features from nuisance sources only effect you if they also have a gamma 

line overlapping a peak you want to use of the isotope of interest

Disadvantages of peak-based:
§ You need at least as many peaks in your spectrum as quantities you want to fit

§ The broader energy range, the better (see next slide)
§ E.x. To fit for activity and shielding thickness, you need at least two peaks (three or more is better) – full spectrum 

analysis can fit for atomic number, areal density, and activity of single-peak sources like Cs-137

§ You are not using spectral information outside of the peaks
§ You aren’t extracting information about scattering environment
§ Full-spectrum analysis uses more information, so can give better results, but can also give 

worse results if scattering environment is not well characterized



Finding shielding atomic number:43

For energies ≳ 300 keV fitting for both atomic number, and amount of shielding 
becomes degenerate – so you really want at least one peak bellow 300 keV 
(preferably a few)
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Finding shielding atomic number (cont):44

Atomic Numbers > 20
80 to 500 keV

Energy (keV)

Atom
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Bottom line: if you want to determine the both effective atomic number, and amount of shielding, using 
a peak-based approach, you want at least one peak below 300 keV, and preferable a few



Fitting activity, shielding, and age in InterSpec

First: fit peaks, associating them with nuclides 
§ Peaks that are in both the background and foreground do not need to be fit.  Or if a peak is for a nuclide you don’t 

care about you can skip it
§ If you have lots of peaks for a nuclide, like a HPGe spectrum of Ra-226, you can maybe fit for just the larger ones
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Fitting activity, shielding, and age in InterSpec (cont.)

From the “Tools” menu, select “Activity/Shielding Fit”
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Activity/Shielding Fit Tool
Select DRF
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Decide if  you want activity 
and/or age fixed for each 
nuclide

You can select 
peaks to use in 
the fit

Select shielding(s)

Enter distance

Some options

Get an idea of  
how good the 
fit is

Fit for the quantities 
you want



Activity/Shielding Fit Tool (DRF)

If you click/tap on the detector area, it will bring up this dialog  
§ We’ll cover DRFs later, but this dialog lets you choose from some DRFs that come with 

InterSpec, enter your own DRF equation, upload a DRF, or select from previous DRFs
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Activity/Shielding Fit Tool (peaks to use)49

Any nuclides associated with the peaks you have selected, will appear 
here
§ You can manually edit an activity, and choose not to fit it, if you happen to 

know it, but not the shielding
§ Age of nuclides is also editable, or fittable for applicable nuclides

All of  the peaks you have fit for 
the foreground will appear in this 
list.
◦ You can choose if  a peak should 

participate in the fitting process.
◦ We’ll cover strategies for deciding 

if  a peak should be included 
during exercises



Activity/Shielding Fit Tool (shielding)50

◦ The shielding can be either a specific type of  material from InterSpecs database, or it can be a generic material where 
you specify the atomic number (AN) and areal density (AD), or you can enter a chemical formula and density.
◦ You can choose to fit for, or fix, thickness, AN, and AD

◦ You can have multiple shielding's, but of  course this can get degenerate to fit for multiple of  them, especially if  they 
have similar effective atomic numbers

Clicking on these icons will 
toggle between shielding types



Activity/Shielding Fit Tool (shielding cont.)51

If  your shielding contains the same element as one or more of  the nuclides you are fitting for, you will 
be given the option to have the shielding become the source term
◦ In this case self-attenuation is taken into account; especially useful in high-Z materials (W, Th, U, Pu, etc)

◦ InterSpec uses an adaptive quadrature based ray-tracing algorithm to account for self-attenuation and geometric effects

◦ If  there are multiple nuclides composing the shielding you can fit for the isotopics as well



Activity/Shielding Fit Tool (shielding cont.)

InterSpec uses a spherical geometry when self-attenuating sources are used

Nuclides that aren’t part of shielding's are point-sources at the center of all shieldings
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6.84 mm solid sphere of  Thorium metal

A 1 cm gap outside the Thorium

A 1 inch shell of  wood

Inner shell

Outer shell

Spherical geometry



Activity/Shielding Fit Tool (distance)

Distance, like times, can be entered in fairly flexible formats; the following are all valid 
distances:

“1.2cm”, “1ft”, “1 ft 13 in”, “1' 13"”, “3 m”, “3 meters”, “3.6E-2 m”, etc
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The distance is from the detector face, to 
the center of  shielding



Activity/Shielding Fit Tool - graphic

The graphic in this tool is to help provide you an idea of how well the data lines up to the model
§ Left: chart shows you how many statistical deviations each peak is away from the model
§ Right: chart shows you the multiple of how far away from the model each peak-area is.  The error bars are 

1-sigma statistical uncertainties.  
§ E.x., if the dot corresponding to a peak is at 2.0, that indicates that peak would give double the activity that is currently showing

Generally, if after doing a “Perform Model Fit,” a peak is greater than maybe 5-or-so-sigma away 
from the nominal value, you should consider removing that peak from the fit, or checking that its 
associated with the correct gamma line, or that there isn’t an interfering nuclide that you aren’t 
currently fitting for
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Activity/Shielding Fit Tool (options)

§ Multiple nuclides contribute to peak: if two or more nuclides being fit for contribute to a 
peak, allow all of them to contribute to calculating the expected peak area, not just the nuclide 
assigned to the peak

§ Attenuate for air: Adds attenuation from the air; between the detector and the outside of the 
shielding

§ Subtract Background Peaks: useful if background peaks contribute to your isotope of 
interest.  To enable this option you must have a background spectrum loaded, and you must 
have the background peaks fit in it

§ To fit the peaks in a background spectrum, first load it as a foreground spectrum, fit the peaks, then load your 
foreground of interest file, and from the “File Manager” tab select the first file as background

§ Background peaks do not need nuclides associated with them; matching of which peaks to subtract from which is based 
on energy

§ Isotopes of same element same age: If you are fitting for the age of a material, like Th, U, Pu, 
etc, and you want to constrain all isotopes for an element to be the same age, select this 
option
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Activity/Shielding Fit Tool (more…)

Clicking on the gear icon brings up a menu that lets you:
§ See a log of calculations, which has a whole bunch of details about what exactly went into 

the calculations
§ You can save, export, import, or load a previous model.  Useful if your model is complex.

§ If you export the foreground to a N42-2012 file, or store it in InterSpecs internal database, your model will be 
saved along with the foreground
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Activity/Shielding Fit Tool (general notes)

This tool requires use of your critical thinking and spectroscopy knowledge – you can do 
things that don’t make sense
§ E.x., if you try to fit for atomic number of shielding using two close-together peaks, or two 

high-energy peaks, you will get a nonsense answer (but you should also get a large error as 
well).  Or if you fit for the age of a nuclide that has already reached equilibrium, you might get 
a really large age (but also hopefully large uncertainty)

§ InterSpec doesn’t currently do a great job of detecting and notifying you of degeneracies being 
fit for

§ Large uncertainties are a “smell” of these

You can only fit for as many quantities as you have peaks for

If you are fitting for the effective atomic number of your shielding, having one or more 
peaks below 300 keV is usually necessary.

Always ask yourself if the results make sense.

Uncertainties given are only statistical.  Uncertainties about your DRF, peak-skew, 
distance, material conmposition, or other factors may dwarf the statistical uncertainties
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Lets fit activity of the Trinitite 
Sample



Some additional information you need:

Lets take 15 minutes to fit activities, and/or as a break.

If you didn’t previously ID as many nuclides as you would like, you can start from my fit 
peaks using the file “Trinitite_Sample_B_peaks_fit.n42” file available from the “Tutorials” 
section of https://sandialabs.github.io/InterSpec/

Additional information that may be useful:

• The trinity detonation happened 07/16/1945

• The date of the measurement can be found in the “File Parameters” tool

• The detector used is an EX-100 – if you have InteSpec v1.0.9 or less, there is a 
“common_drfs.tsv” file on the Tutorial page that has the DRF.  InterSpec v1.0.10_rc3 and 
above will automatically load the DRF

• You can assume a (roughly estimated) distance of 5 cm from the sample –the distance 
isn’t known well
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https://sandialabs.github.io/InterSpec/


Trinity Sample Activities60



Trinity Sample Activities (cont):

A few of the Eu152 peaks overlap with NORM background peaks, so we need to account for this.

• I loaded the background spectrum as a foreground, used the automated peak-search 
function, and then quickly cleaned up a few peak fits – did not assign nuclides to background 
peaks
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No background-peak subtraction With background peak subtraction



Trinity Sample Activities (cont):

Some peaks of interest have background 
peaks that either partially overlap, or totally 
overlap.  Shown here:

• The 969 keV background peak had to be fit 
so the 964.1 keV Eu-152 peak would be fit 
well.  

• There is a background peak at 964.8 keV 
(from Th232) that totally overlaps with the 
Eu-152 peak – this needed to be fit in the 
background spectrum in order to account 
for it in fitting activity
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Trinity Sample Activities (cont):

Adding a shielding, and allowing its thickness to be fit for helped improve the fit.

• This is mostly to account for the self-attenuation of the sample itself

• The type (i.e., the effective atomic number) of shielding doesn’t matter much, we 
don’t have the statistics to differentiate much

• If we take the shielding to be iron, it fits for about 1 mm – so not much
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No Shielding A little bit of shielding fit for



Trinity Sample Activities (cont):

The Eu-152 peak at 244.7 keV appears to be a bit of an outlier

• It has ~5 sigma fewer counts than the other Eu-152 peaks would predict
• (The 5 sigma is statistical only, and doesn’t account for systematic errors that like the quality of 

the peak fit might contribute to)

• If you wanted, you could remove the peak from the activity fit, or you could go back to the 
spectrum and see if maybe a different continuum model would work better

• I choose to leave it in – 5 sigma is about my personal comfort level to leave peaks in
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Trinity Sample Activities (cont):

Age matters for the Pu-241 activity

• We actually see the 59 keV peak from Am-241.  If we had assigned the 59 keV peaks as 
Am-241, then the age wouldn’t matter

• For most of the isotopes in this spectrum, the relative intensities of the peaks don’t really 
change over time.  

• For Pu-239 and Pu-241, we don’t have peaks from multiple progeny isotopes, so the 
option to fit the ages is not given to us
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Trinity Sample Activities (cont):

The distance was 5 cm - this is closer than the DRF approximation is valid for

Detective-EX100 detection element is 65 mm x 50 mm

66

65 mm

50 mm

InterSpec models the detector as a flat-disk.  

I.e., the gamma-rays coming in from the source are all parallel.  

I.e., distance between the source and the detector is much larger than the size of the source or detector

This approximation starts becoming valid when distance between source and detector is much larger than the 
detectors diameter, or source size

Also, the DRF we have is probably not from the same detector used, so this could be up to maybe 20% difference



Trinity Sample Activities (cont):

However, Mercer, et al list the activities in Bq/gram, at date of detonation

To compare we need to back-decay these activities to 1945 
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https://arxiv.org/abs/2103.06240

https://arxiv.org/abs/2103.06240


Trinity Sample Activities (cont):

The “Nuclide Decay Info” tool can help us.  

On the “Calculator” tab, if the “End Date” is before the “Initial Date”, then things will be back-
calculated

• This is only true for InterSpec ≥v1.0.10_rc3 – before that you’ll have to have to have the 
“End Date” after “Initial Date” and manually do the extra multiplication

I used the “Math/Command Terminal” to divide original activities by 126.6 grams
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Trinity Sample Activities (cont):

For most of the nuclides, we are ~50% high, except Pu241/Am241, we’re off by a factor of 3

• If we drop the shielding from the fit (ex., ~1 mm Fe), then Pu241/Am241 activity drops by a 
factor of ~2.5, bringing us inline with other estimates

The distance and/or DRF is likely a little off – but overall not to bad
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Nuclide InterSpec Mercer, et al

Co60 109.6 65.7 ± 15.1

Ba133 16.32 11.3 ± 0.6

Cs137 120.7 81.1 ± 3.1

Eu152 49.6 35.7 ± 1.4

Eu154 6.8 8.2 ± 1.7

Pu239 375 317 ± 144

Am241 7.36 2.5 ± 0.2

Pu241 259 82.9 ± 6.6

Activity in Bq/gram of ”Sample B”, decay corrected to date of detonation 
(except Am-241, its activity is at date of measurement)



Enrichment Calculations



Enrichment Calculations

As mentioned earlier, if your shielding contains the same element as one of your source 
nuclides, an options will appear to make it a self-attenuating source

• This uses a ray-trace algorithm to integrate over the source volume, and correct for self attenuation

Please load “uranium_40%_HPGe_15cm_peaks_fit.n42”; it contains the DRF, peaks have been fit 
for, with nuclides assigned, and is ready for you to fit the activity/mass to.

• Use a distance of 15 cm

• Assume a solid sphere

• No need for shielding outside the Uranium
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Enrichment Calculations

1. After loading the spectrum, to to the 
“Activity/Shielding Fit” tool

2. Enter distance, and add a Uranium 
shielding

3. Select peaks you want to use
§ Some of the U235/U238 peaks have x-

ray interferences, you probably don’t 
want to use these

4. A “Source for” box should appear in 
the shielding, and you can select to 
use the shielding for U235 and U238; 
you can then choose to “Fit Mass 
Fractions”
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Real answer: 1 kg, 20% enriched sphere
Fit answer: 915 g, 19.6% enriched



Contamination Calculations



InterSpec for soil and other contamination analysis

InterSpec supports determining contamination 
via adding trace sources to a shielding
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End-on Cylinder Side-on Cylinder RectangularSpherical



Homogenous and exponentially distributed trace sources

Trace sources can either be 
a) uniform: determined as activity per cm3, total activity, or activity per gram
b) Exponentially distributed sources, starting from surface facing the detector

Trace sources are volumetric source-terms in the shielding's – they do not affect the 
attenuation of the shielding
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𝑓 𝑧 =
𝑆!
𝐿
𝑒"#/%

𝑆! = 𝑡𝑜𝑡𝑎𝑙 𝑎𝑐𝑡𝑖𝑣𝑖𝑡𝑦 (
𝐵𝑞
𝑚")

𝐿 = 𝑟𝑒𝑙𝑎𝑥𝑎𝑡𝑖𝑜𝑛 𝑙𝑒𝑛𝑔𝑡ℎ (𝑐𝑚)

63% of activity is within one 
relaxation length of the surface

Uniform trace 
source distribution

Exponential



Basic idea for analyzing soil measurements in InterSpec

In the “Activity/Shielding Fit” tool, use a shielding composed of soil that is effectively 
“infinitely large” with one or more trace sources

§ The dimension along detector axis should be many attenuation lengths of highest 
energy peak used for analysis

For 2614 keV, 2 meters in soil would attenuate 99.999% of gammas

§ The radial (cylindrical) or width/height (rectangular) dimensions should be large enough 
to cover the detector’s field of view

For detector 1-meter from ground, needed radius ranges from 15 m (homogeneous), to 210 m (pure surface)

§ Increasing dimensions beyond the effectively infinitely large dimensions wont change 
answers

i.e., for soil contamination, using cylinder with height 2 m, and radius 225 m is a good default to use
Also, when an exponential distribution is selected, dimensions to use will be suggested

You will then fit for trace-source activitie(s)
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Shielding geometries and distances in InterSpec

The “Distance” entered in the “Activity/Shielding Fit” tool is from the center of the 
shielding to the detector
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2 m

1 m

2 m

“Distance” you would enter

Detector to ground distance

You would enter a half-length of 1 m

Example: if you want to represent soil as 2 meter thick, end-on 
cylinder, with detector 1 meter from the ground:



Case-study: Eu152 surface contamination (cont)

Paper coated with Eu152 were distributed over a 21m x 21m area to simulate fresh fallout.  A 
Micro-Detective was used to measure contamination 1m above the ground, pointing down.
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21 m

21 m

This measurement was performed by P. SLADEK and 
group of Nuclear Science and Instrumentation 
Laboratory (NSIL), Physics Section  Division Physical & 
Chemical Sciences, IAEA. 
This and similar measurements were discussed on an 
IAEA webinar presented 20211117, and is available at 
https://elearning.iaea.org/m2/course/view.php?id=1224



Case-study: Eu152 surface contamination (cont)
There are a couple ways you could represent this scenario

1. As an exponential surface contamination, with very short relaxation length
2. As a thin “air” volume, with uniform trace-source distribution
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We’ll demonstrate this one

21 m

21 m

1 cm

This measurement was performed by P. SLADEK and group of Nuclear Science and Instrumentation 
Laboratory (NSIL), Physics Section  Division Physical & Chemical Sciences, IAEA. 
This and similar measurements were discussed on an IAEA webinar presented 20211117, is is 
available at https://elearning.iaea.org/m2/course/view.php?id=1224



Case-study: Eu152 surface contamination (cont)
The steps for analysis is similar to before, but this time choose a rectangular geometry 
of air, set the dimensions, and click on the “+” button to add a trace-source

80

Choose a total thickness 
of 1 cm, for convenience

“Width” and “Height” are 
entered as half-values –
this makes things easier 
when there are multiple 
layers Multiplying by 1 cm, gives 

surface contamination of 
246 mBq/cm2

(known value: 252 mBq/cm2)

Add 0.5 cm to distance to 
make up for 1 cm thickness



Warnings about volumetric-source calculations in InterSpec

• The angular response of the detectors is not taken into account.
• Not typically a large effect (think 10%), but has not been rigorously evaluated
• This is expected to be added in the future

• There are likely to be larger systematic uncertainties to consider

• There are a lot of things to consider about the sampling that aren’t covered here
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Detector Response Functions



Detector Response Functions
To determine an unknown source’s activity, or unknown shielding, or nuclide age 
you usually need to know the photo-peak detection efficiency of the detector.  

You either need to determine your own detector response function (DRF) using 
known check-sources, and the “Make Detector Response” tool

• See tutorial dated 20190619 on the InterSpec tutorial site for how to do this 

Or you can use a DRF supplied with InterSpec, or by some-one else 

• Usually this is for a detector of the same model – and is close enough
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Detector Response Functions – supplied by others

As of version 1.0.10_rc3, InterSpec includes a 
number of common detector response functions

• If InterSpec detects a file loaded from a 
detector it has the DRF from, it will prompt you 
if you would like to use the default DRF for that 
model always 

Or you can import DRFs in various CSV formats, 
as a mathematical formula, from GADRAS 
Detector.dat and Efficicency.csv files

You can also have InterSpec always use a specific 
DRF for either a specific serial-numbered 
detector, or for a given model

• I use the defaults on a per-model basis, so 
rarely have to manually load DRFs
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Viewing Portal/Search-mode 
data



Portal/Search-mode data

RPM Portal and search-mode systems often record data at regular short-intervals (e.g., 
one spectrum every 0.1 seconds)

When you load one of these files in InterSpec, a time-history chart will appear
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Portal/Search-mode data (cont)

You can click-and-drag on the time chart to select which samples to sum to make the 
foreground

Holding shift and dragging will add additional samples

Holding “option” key and dragging will select background samples; option-shift will add 
background samples 

Hitting escape while dragging will cancel current operation

Right mouse-button, or mouse-wheel will zoom-in-out

+ more action… but I don’t even remember all these – so click on 
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Portal/Search-mode data (cont)

In this “settings” panel, you can just select the operation you want to do.  

It also reminds you of the short-cuts if you are a power-user
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Portal/Search-mode data (cont)

You can also choose to filter the time chart to just be the sum of counts in a given energy range

And there are some display options
• “Don’t rebin”: this is when there are more tiem-samples than pixels on your screen – instead of summing 

time-samples for a pixel, it will plot the max counts during the time intervals of that pixel – useful for long 
measurements with only short blips of signal

• “Hide neutrons”: sometimes the neutrons are just noise for your problem; you can hide them
• “Rel. y-max”: poorly named, but a value <1 emphasizes neutrons on the chart, while values >1 emphasize 

gammas.  Keeps neutrons or gammas on the chart, but will lower the line you are not as interested in so the 
measurement type you do want, pops out a bit more
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Other calculations



Flux Tool

Converts your peaks count rate into gammas into 4 pi steradians
• Has a few different format tables to accommodate different use cases
• You can copy results to the clipboard, or download as a CSV file
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Dose Calc

Calculates the dose from gamma sources
• Accounts for scattering of gammas in shielding and air (i.e., full spectrum)
• Always adds in shielding due to air
• Provides a quick/handy reference table to put the dose rates in context
• Or if you measured a dose, lets you easily go from that to source 

strength/shielding/distance
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Nuclide Decay

We already used this tool a bit, but a few things to mention about the “Decay Chain”
• You can click on an nuclide to get further information about the nuclide
• You can double-click on a nuclide to get a list of decay products when it decays (only 

includes products from that parent nuclide, not further prodigeny)
• The “Show Decays Through…” feature is also useful to find other potential parent nuclides
• E.x. If you are seeing gammas from Tl-208, you might want to check where the Tl-208 is coming from
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Nuclide Decay – CSV export

If you want to plot a gamma intensity, progeny activity, ratio of activities, or other 
quantities over time, there is a CSV download option on the “Activity Chart” tab
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1/r2 Calculator

Fairly standard 1/r2 calculator, but does give you the option of high, medium, or low 
scatter

• If you can use a peak area, this is best – and would be using the “Low” scatter option
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Terminal and Units Converter

There is a radiation-analysis related units converter tool.
• Useful for going between Bq and Ci, or meters and feet, etc

There is also a “Math/Command Terminal” tool that lets you programmatically access 
some quantities, as well as lets you do some simple algebra and math

• I find this easier than using the Windows/macOS calculator a lot of times
• A few users have reported using this as a “macro” type language and have requested 

additional functionality 
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Spectrum Manager

The “Spectrum Manager” can be used to more-fine-grained control which spectra are 
currently displayed

Also can be used to sum spectra, or combine multiple spectra in a new file (e.g., put separate 
CHN foreground and background files into a single N42).

97



Backup slides98



Case study: Chernobyl measurements 

Do same steps as previous examples, but:
• fit peaks for Eu154, Cs137, Co60, and Cs134
• Use a end-on cylindrical, or rectangular geometry, 

with sufficiently large dimensions
• Add a trace source for each of the four nuclides
• Select “per m^2 exp” activity type – this will cause a 

“Relaxation Distance” enter form to appear
• Enter “3 cm” for relaxation distance
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